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Part List | Lista de partes | 1 ;2Y1 2

MC4.0 controller | controlador MC4.0 | MC4.0 aSaia Chassis | Chasis | Jsugll

Encoder motor Module | Médulo motor codificador | Add-on Fixture | Accesorio adicional |
alSjaall asaill 6ang cwdill aalal
Battery Module | Médulo de bateria | ayjlla 6aag DC Encoder Motor | DC Motor codificador |
o ga paiue o

Fixing Plate | Placa de fijacion Mecanum wheel | Rueda Mecanum



RGB Line-Follower sensor | Sensor Ultrasonic sensor | Sensor Screwdriver | Destornillador |
seguidor de linea RGB | hall g.:_d.‘iglg]i ol ultrasénico | Ligall §ga dabua yubua WElp clao

Motor shaft coupling | Acoplamiento Brass Studs | espaciadores | Screws M3x30 | Tornillos M3x30 |
del eje del motor | wlSyall Ylfil jgae alaclia 3x30 ywlid Lelp

TRTITT e
aeaes SEARY

Screws M3x25 | Tornillos M3x25 | Screws M4x8 | Tornillos M4x8 | Screws M4x10 | Tornillos M4x10 |
3x25 ywba £lp 4x8 yubid £lp 4x10 yubid £lp

~ //
> G
>
Screws M3x35 | Tornillos M3x35 | Motors Cables | Cables de motors | Grove Cables | cables de Grove |

3x35 ywba g‘EIH alSpall EluLwi Grove ggi &libwf



What is MC4.0 made of | De qué esta hecha MC4.0 |
MC4.0 ()gSis Loa

Power ON 6 seconds OFF | Interruptor de Encendido, 6 segundos APAGADO | §uéull L",jlg.? 6 il alics
USB TYPE-C | USB TIPO-C | C ggi daopll 3aia
PORT A - 12C | PUERTO A - I12C | A Adian
Touch Screen | Pantalla tactil | duuwal &bl
What else do you find inside?
2" LCD 320x240 | LCD de 2" 320x240 | il 2 yulié yiye ddblis :Qué mas encuentras dentro?

Reset Switch | Interruptor de reinicio | Jueiill 8sle| alico Léui Jalall aailile

LED | CONDUIJO | _igi pisgo

00000000

SD Card | Tarjeta SD | jSlga sg)la

IMU IMU auglill ywlid 3aag

1W Speaker Altavoz de 1TW dlg | agua fSo
Real Time Clock Reloj en tiempo real un.m.:JI agll aclw
7.4- 8.4V 2000mAh Battery Bateria de 7.4 - 8.4 V 2000mAh ol Lllo Fo/foulgd A€ V.E aylhy
Vibration Motor Motor de vibracion jlfml ¢ljpo

Microphone Microfono

Jg9ag)Sio



Assembly Instructions

Assemble your educational robot and start your Robotic journey

MC4.0 is the world’s most ingenious Multi-coding robotics AloT kit for every student
from school to university to learn all STEM concept (Science, Technology, Engineering,
Mathematic) and experience the charm of mechanics, electronics, control system and

computer science.

Scan for Assembly
Video

start! o e

~\
vl Fixing Brass Studs | Brass Studs Fixed
Fix the brass studs on the chassis using Complete this step prior to motor installation.
M4x8 screws
Ll Chassis 1Pcs
[] M4x8 4Pcs
[l brass Studs 4Pcs
J
—© 4

V| The Motors Installing | Motor Installed View

Attach the motors with the chassis with M3x25 screws This illustration displays the proper motor
and hold the screws with M3 nuts placement from the bottom view.

[l DC Encoder Motors 4Pcs

[1 M3x25 4Pcs

[l Fixing Plate 4Pcs
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VI Motor Shaft Coupling

Fix the motor shaft coupling with wheels
Wheels 4Pcs
Motor shaft 4Pcs

16/ \

D/ The Wheels Orientation

The directions of the wheels shall be installed in
the following orientation so that the diagonal
directions are the same or closed a V-shape
from the frontside and the backside

DC Encoder Motors 4Pcs
Wheels 4Pcs
Motor shaft 4Pcs

9

V| Wheels Fixing
Attach the wheels to the motors shaft using M3x30

DC Encoder Motors 4Pcs
Wheels 4Pcs
Motor shaft 4Pcs
M2 .5x30 4Pcs

Ii]/ MC4.0 Controller

Stack the MC4.0 controller with the DC encoder
module and Battery base module

MC4.0 controller 1Pcs
4 Encoder DC Motor Module 1Pcs
Battery base module 1Pcs
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Iil/ MC4.0 control unit M MC4.0 control unit

Attach the MC4.0 controller unit on the chassis
using M3x25 screws

[ MC4.0 control unit 1Pcs
[l M3x35 screws 4Pcs

% N ’

M Ultrasonic sensor M Line Follower sensor
Fix the ultrasonic sensor in the front of the Place the line follower sensor in the bottom of the
chassis using M4x10 screws chassis using M4x8 screws
[l Ultrasonic sensor 1Pcs [l Line follower sensor 1Pcs
[1 M4x10 2Pcs [l M4x8 2Pcs
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vl After placing sensors V| Fixture Add-on

Put the add-on fixture on the brass studs
using M4x8 screws

Chassis group 1Pcs
- Add-on fixture group 1Pcs
- M4x8 screws 4Pcs

~®

V| LetIt Go!

{ /X\} JMAKER
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Let's wire up your robot and bring it to life!

Whether you're a beginner or an advanced learner, MC4.0 offers a comprehensive set of wiring instructions to help you
understand the principles of electronics and control systems.

Start! o p

| Motors Wiring

Connect the motors wires to the DC encoder !55! ‘PERICER, [FIEET m
module with the white connectors

FL = Forward Left Motor
BL = Backward Left Motor — .
FR = Forward Right Motor
BR = Backward Right Motor

e © .

| Motors Wiring ¥l Ultrasonic & Line-Follower Wiring

The wires are bent from the bottom and hidden The wires are connected to both ports B and C
in the chassis in this way PortC = Ultrasonic Sensor
PortB = Line Follower Sensor

oo« TOSEN |
m Line-Follower

\. END




Wiring Instructions - 126 Sensors

Let's wire up your robot and bring it to life!

Whether you're a beginner or an advanced learner, MC4.0 offers a comprehensive set of wiring instructions to help you
understand the principles of electronics and control systems.

Start! o \

[i[v/ Motors Wiring

Connect the motors wires to the DC encoder
module with the white connectors

FL = Forward Left Motor
BL = Backward L Motor
FR = Forward Right Motor
BR = Backward Right Motor

B © ’

| Motors Wiring V| Ultrasonic & Line-Follower Wiring
The wires are bent from the bottom and hidden The wires are connected to PORT A
in the chassis in this way -

END




Get Started

Ready to unleash the full potential of your MC4.0 kit

Let's get started with your MC4.0 kit! In this section, we'll guide you through the steps to operate your robot and connect
it to the Wi-Fi network, so you can start exploring the world of robotics and AloT.

Start! o ~

Iﬁ Turn ON and Connect

Turn On the module by switching the pin to ON and ensure the voltage is Vin as shown in the image.
Now turn ON the MC4.0 by pressing the Power button at the side. MC4.0 supports three programming
methods: USB cable, Wi-Fi, and Bluetooth (BLE). All offer the same features, but the web IDE adds
wireless communication and loT capabilities. To use the web IDE, MC4.0 must be connected to Wi-Fi
and paired using its API key. For offline environments, the MC4.0 can be connected via USB, or BLE

allows direct pairing with a device without internet access, making programming flexible and accessible.

Mk

[ P

Vin— Set thivte

N/EFF — Suich this G aftar connaction «( »

==

Type-C LS8 cuble

Wi-Fi mode USB Mode BLE Mode
—©

¥ WiFi Config
1. Short press the power button on the left side of the MC4.0 for 2 seconds to turn on, and the Maker and Coder
Logo appears on the screen. After entering the main page, press the "Setup” button on the screen

2. In the Wi-Fi option, press the start button of the config Wi-Fi by web option, and the device will automatically
restart.

Wi-FI  Mclab  System

Press Start After auto restart
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¥l WiFi Connection V| WiFi Setup
3. Once the device is up and running, you'll see the WiFi 4. After connecting to the SSID shown on the
Config page. Simply find the device SSID hotspot name, and screen open the browser to access 192.168.4.1,
jump to your mobile phone, Tablet, iPad, or computer's WiFi and enter the WiFi information in the pop-up
settings,and connect to it to proceed. page to configure it successfully. After the

configuration is successful, the device will
automatically restart, and enter the online

programming mode.

=
]
Device SSID b e

MCLab

*_" WiFi connection success

Wik Setup
Heset device now -

Wl SSID: _MC-14rc -
P : 19306041

Connect this SSID and open
the 1P in yous Browser, enter
your Wi-Fi password,

—O r

¥ Pairing with MCLab

5. Open your browser, enter the URL www.mclab.ai and use the APl KEY shown on the device

AP KEY:

&£ XXMCA0XX

Open your browser, ener the URL
www.meclab.al, and usa this
AP| KEY 1o gel started!

Welcome to MCLab

PO oevce Lowcimo 0]

e AP1 ey and connect to

MCLab Platform
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[ﬂ USB Cable Connection

When programming with the offline version of MCLab, you need to configure the device to USB mode.

1

Short press the power button for 2s to start the device

. After the menu appears on the screen, quickly click the “Mode” option.

2
3
4

Select the USB mode.

Select the corresponding port in the configuration box of MCLab Desktop IDE, and the programming device,

click OK to connect.

chacse mode|wil rebaat)

(wire) (men)

S

Press Made choose USB

@ s (6]

Downioad MCLab Deskiop IDE

freem “hitps:iimakerandcoder.com/
downloads/Softwara/mclab-
windows.zip” and connect your
cormputer with USE-C cable

After auto restart

¥ installing MCLab IDE

To install the MCLab IDE on your device, scan the QR code and open the link in your web browser. Then, choose

Setting

the suitable operating system and click on the 'Install’ button to proceed. Once the installation is complete, open

the IDE and remember to select the correct COM port and device before programming your MC4.0 kit.
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[ﬂ BLE Connection

When programming with BLE option in MCLab, you need to configure the device to BLE mode.

1. Short press the power button for 2s to start the device

. After the menu appears on the screen, quickly click the “Mode” option.

2
3. Select the BLE mode.
4

. After auto restart of MC4.0 the BLE address will appear on the screen.

BLE Nams:
chacae modsiwl rebaat)

* EDNEX-XMCA0X

(LB} (WiEe)] @ Open your browser,enter she URL
s www.mclab.ai, and connect
- o

PR— fo BLE Mame to gel stacted|

Press Mode choose BLE Arter auto restart

¥ Pairing with MCLab

1. open mclab.ai

2. Select “Device” option

Setting

3. browse available devices (search near by devices will start)

4. Select the same address shown on the MC4.0 screen.

o

melabai wants 1o pair

A EDNER-RMTATY

Vs ™
@ v ( cament )
i

END




Discover the simplicity of block-based programming with MCLab!

Block-based programming with MCLab is designed to be easy and simple, even for beginners. In this section, we'll show you
how to use MCLab to create code for your MC4.0 kit in a fun and interactive way. With a visual interface similar to Scratch,
MCLab makes it easy for anyone to start programming and bring their ideas to life.

.

“Hello world” has long been held as the induction to programming, regardless of what language |

Hello World

is being taught. It teaches the most basic of programming concepts and prints "Hello World" to
the screen of the device. While it may sound simple, even some seasoned programmers may use

this code as a test when trying a new language or device for the first time. Once we have learned |

the hello world program it will give us the confidence to go on to learn more advanced things.

So let’s get started with our “Hello world” program

Start by dragging a label [ESE. » Hardware
on to the Ul Manager from |58 B » Units

the left panel. H- Modules

» loTCloud

oud

5y I Event

Ppu

» Hardware

o labeld
: Name: fabei0
X128

Y. 106

a pop-up message will appear color [

Text, labeld

to let you set all the feature §% T ey

of the label, you can change the [

color, text, font, and others Uit DC Mator

el




P Hello world - Displaying text and pictures MC4.0 Manual - Block-Based programming
EEms———— _ s S e ]

Click on the Ul section of the blocks menu and you'll notice there is a sub-menu titled "label". Inside the label we'll find a bunch of
different blocks which can be used to program the text label. We will choose the first in the list for now "Label” (label_name)
show [text] Drag this block into the coding area and connect it up to the setup block. Now we can enter "hello world" inside the

text field, or any other message for that matter of fact.

Click on the label blocks - G Drag it into the coding 9 change the text
select label show block area and connect it to the to “Hello World*

.. | setup block

N I Bvent
|v Wi
Lavel
Screen

(561 [T color

» Hardware “u -
> Uhilts oo - EUETR o EX o BT o |
|b Modules = sl
- labei0 - Lo ]
» loTCloud
"1 labeio - TE7Y Montserrat 10 - |
EzData

F— e ecen B comer TR o B o [scoen |

C Cloud

| sromu) B g e (X2

Now you've created your very first program. That was easy, wasn't it? Now in order for it to run on the MC4.0 we need to make

sure that your WiFi setup is done, or your USB cable is connected if you are using USB mode, or BLE paired

=y

| Event
I' u
Labet
I» H-:1'!Ju;-.;ﬂe ) : [ :
> Units
lb Modules

» loTCloud

MC Cloud

| EzData

DC Motor

Gyro (IMU)

If your MC4,0 Device is connected properly

Click on the play button at the bott
you should notice The word "connected” in green. FERON R play. DULOR ZkEhe Satom

il right-hand corner of the window to run
If you don't see it click on the refresh Icon g

your program

next to it to try to reconnect.



P Hello world - Displaying text and pictures

MC4.0 Manual - Block-Based programming

Adding images to your MC4.0 screen is a breeze with MCLab. Simply drag and drop the 'Image' object from the left menu to your

desired location on the screen. From the pop-up message, you can easily upload your image. Be sure to keep your image size under

50KB and its dimensions no larger than 320x240 pixels to ensure optimal display.

Start by dragging a Image
on to the Ul Manager from

the left panel.

ﬁ Set your image position g Upload the image

Label

!
Label+

Image Path: default png

| Name: image0
X: 0
Y:[0

v Reload E:—n-

Layer: 6

MC Cloud

l‘ EzData

DC Motor

Gyro (IMU)

Once you've uploaded your image, be sure to select it from the list of uploaded images in the pop-up message. The selected image

will be displayed on both the MCLab screen and your MC4.0 device's screen

Image Path: defaull png
Layer: | default.png
= Fage 01_v1.png
Page_2.png

| €:pa hapPy.Yelawpng

DC Motor

Gyro (IMU)

After, Select the uploaded image
and once selected it'll be shown P
on the MC&.0 screen

o




P RGE Color MC4.0 Manual - Block-Based programming

Get ready to add some color to your MC4.0 project! In this next example, we'll explore the RGB bar located at the bottom of MC4.0
With MCLab, you can easily adjust the RGB values to create your own custom colors and make your project pop. Let's dive in!

So let’s getstarted

o Start by dragging a label on to the

Ul Manager from the left panel and
change the text to RGB Color. 9 Drag three Sliders to the Ul Manager

N I Event
IP Ul

» Hardware

» Units

e ' l» Modules

» loTCloud

MC Cloud

EzData

Adjusting the length of the sliders changes the intensity of each color, allowing you to create a wide range of colors. Keep in mind
that the maximum value for each color is 255, so adjusting the sliders to the desired length within that range will give you the

best results. e By clicking on the Slider the pop-up window will appear and

you can change the position, width, and Max value as shown

I Event

!r Ul

» Hardware

slider1 X slider2 X
X145 x| 45
Yi 149 Y| 210
Name: | siider1 Name:  slider2
Width] 250 | Width:| 250 |
Height: 12 Height: | 12
Min Vaiue: |0 Min Value: 0

Max Valuai 255 | Max Value:| 255

Track Color. R | | Tec wm—J
Color: Color:

Layer: |11

Layer: |10

Line Follower Sensor




P> RGE Color MC4.0 Manual - Block-Based programming

To make things even easier, we can label the sliders with the letters R, G, and B to correspond with
each color channel. With these labels in place, we can easily add the necessary blocks to control the

RGB LED on the MC4.0.

To begin programming the RGB example, you must ensure your program runs continuously. To achieve
this, you will add an infinite loop to your code. Next, you can find the specific block for the RGB bar

under the 'Hardware' tab in MCLab. For each color, you will use the corresponding color from the

sliders.
Click on the Event blocks - Drag it into the coding

select loop block area and connect it to the

setup block

'r ul

» Hardware
» Units
'b Modules

» loTCloud

MC Cloud

ﬂ EzData

DC Motor

Drag it into the coding
Click on the RGB blocks - select

Set RGB Bar Color block

area and connect it to the

Loop block

=
I Event
'b ]|
| ¥ Hardware
Speaker

hone

Qﬁ- @‘

W
@ oo

EXPLORE, INNOVATE, EXCEL



=¥ RGB Color - LET's move MC4.0 kit MC4.0 Manual - Block-Based programming

Once you have finished, you can click on the 'Run’ button located in the bottom right-hand corner of the screen. From there, adjust

the R, G, and B sliders to select your preferred color.

change the Sliders name

Drag it into the coding according to the each color
Click on the Slider blocks - )
lect label Get block area and connect it to the R > slider0
select label Get bloc G > sliderl
I Set RGB Bar block B > shider2

*I ¥ </> Python
s (T oo < o] o

s 8 o o e

S (2R (290

wWQer CLBEAD Z@a=

RGB Color

et [T ke
et EZD tchgrmtcoi oy 2 W 0 ol © R
et [T bochpamiCoir « 2R

o 2R e ol

e N wack coie sy 4 o = o]

st (TR e Cotor ST

s £ e o

ot (IR e i o] e off

e - L]

= I 2R cunged wite (720
DC Motor

Hide Ul o C

LET’s move MC4.0 kit
— » .—/

The MC4.0 kit comes equipped with mecanum wheels, which are special wheels that allow for omnidirectional movement. Mecanum wheels

have a unique design of angled rollers that enable the wheel to move in any direction, including sideways and diagonally. This makes the
MC4.0 kit is highly maneuverable and versatile, as it can easily navigate around obstacles and change directions on the fly. In the next, we'll take
a closer look at the movement capabilities of the mecanum wheels and explore how they allow the MC4.0 to move in any direction. Then, we'll

delve into the programming side of things and see how we can control the movement of the MC4.0 with MCLab.

If two of the side wheels move

When all the mecanum wheels
on the MC4.0 are moving in
the same direction, it will
move either forward or
backward.

when two of the side wheels
move in the same direction the
MC4.0 kit will move in a
stationary clockwise or
anti-clockwise direction

in the same direction while the
other two move in the opposite
direction, the MCA4.0 kit will
rotate in a stationary clockwise
or anti-clockwise direction.




P LET's mave MC4.0 kit MC&.0 Manual - Block-Based programming

When two of the wheels move anti-clockwise and the other two move
clockwise, the MCA4.0 kit moves in a sideways direction by rotating the front left wheel

in the opposite direction of the
front right wheel while keeping
the back wheels stopped, the
MC4.0 will move in a circular
path. This is because the
mecanum wheels are designed
to allow for omnidirectional
movement, and by rotating the
front wheels in opposite
directions, you create a
sideways force that causes the
When move two diagonal wheels in the same direction , the MC4.0 kit MC4.0 to move in a circular path.
will move diagonally along that axis

Now that we understand the basics of the mecanum wheels and how they work, let's dive into programming the MC4.0 kit to move
using block-based programming and MCLab. here we'll explore how to use the specific blocks for motor control, how to set the motor

speed and direction, and how to combine these blocks to make the MC4.0 move in different directions and patterns.

: 5 .
Let’s get Started! 9 W 9 Select the desired block to o Add Loop block into Setup block
program the movement of as we did earlier

I the car.

» Hardware Move £200 o ] C8 oot W %

» Units T

» Modules St moter costol mator WER (1~ 45 W] @ - 1) spest o] 10100y

» loTCloud Satrbo v s oY & (0

MC Cloud Whator stop motor n (=4
EzData i forecard spoecd ﬂ 0~ 100)
DC Motor Nt N - 98

Gyro (IMU) o e gesd oY €=w0

Line Follower Sensor | (istsdseesd L) 0=160)

Ultrasonic Sensor Hotate sightside speed W] (0~ 1000




PP LET's move MC4.0 kit MC4.0 Manual - Block-Based programming

Congratulations on reaching the programming section of the MC4.0 manual! It's time to write your first example and make the car

move in a specific direction using block-based programming with MCLab. This will be an exciting moment because you'll see your

MC4.0 car come to life as you program it to move.

Add the "Init DC motor module” block o Click on the Timer blocks and chose wait

option, increase the time as wanted

Init DC motor module » Al Tools

Variables

Run forward speed ﬂ (0 ~100)

Math
Loops
Logic
Graphic

_ Get ticks ms
Emoiji

©| Timer

Functions

Text

Lists

This program will allow the MC4.0 kit to move forward for 1.5 secands, then move towards the right sidewalk for 1.5 seconds,

then move backward for 1.5 seconds, and finally move towards the left sidewalk for the same duration of time.
Let’s test other way to control MC4.0 kit

e Motor Number o Motor Speed
| o Motor Direction |

| This program will make the MC4.0 move forward for
Set motor control motor Wil (1~4) dir (BB 50 MBSO 5 duration of 2 seconds and then come to a stop.

Set motor control motor WEY (1~ 4) dir CERIEEER" 5o WUESEUN However, if you want to have more control over the

Init DC motor module

Satmoter contral motor (1~ 4) dir n (0~ 1) speed ﬂ GRSl motor movement, you can use the individual motor

BRtioiof eonvel o n (hi=hidie ﬂ (0 ~ 1) speed ﬂ MERlW blocks. These blocks allow you to specify the speed
vt o and direction of each motor separately. To use these
e n (1 ~4) blocks, you will need to enter data into the table below,

which specifies the speed and direction for each motor
Motor stop motor ﬂ (1-4)

Motor stop motor ﬂ (t=4) Motor Number Motor Direction | Motor Speed
e
Motor stop motor n (1~4) eft rear

| 0 >> Backward
1 > Forward |
| 0 >> Backward
1 >> Backward
0 >> Forward
1 >> Backward

| 0 >> Forward

Left front
0% to 100%
Right rear

Right front



P Ultrasonic & Line-Follower sensors MC4.0 Manual - Block-Based programming

Ultrasonic & Line-Follower sensors

—
The MC4.0 kit comes with an ultrasonic sensor and a line-follower sensor, both of which can be easily controlled through the

block-based programming language. The ultrasonic sensor is equipped with RGB eyes that allow it to detect objects and measure

distances. The line-follower sensor detects differences between dark and light surfaces, enabling MC4.0 to follow lines or explore

specified courses.

: - This block initializes the ultrasonic sensor and must be placed before the main loop to ensure proper
Init ultrasonic sensor [3/34 [+ e P L

operation; it can be configured to use either Port A or Port C

Get RGE ulirasonic target distance value mode (YN (return float) 9 With this block, you can read the ultrasonic value in MM or CM

o These blocks are used to control the RGB eyes of the
ultrasonic sensor. Each eye contains three
RGB LEDs: LEDs 1, 2, and 3 for the left eye, and
brightness ﬂ (0 ~100) % LEDs 4, 5, and 6 for the right eye.

Set RGB ultrasonic LED index n (1= 6) color brightness m (0= 100) %

Set RGB ultrasonic LED all color brightness WffER (0~ 100) %

A This block is used to initialize the line follower sensor. It must be placed before the main loop and before
Init line follow sensor

any actions involving the sensor. You can initialize the sensor on either Port A , Port B, or Port C

This block reads data from all five points of the line follower sensor (1 to 5).

Get multi-channel line follower sensor 1 ' ‘ ‘ ' ‘ o You need to insert a separate variable for each point to store and access the

reflected data individually

This block is used to read data from a specific point on the line

9 follower sensor. It allows you to select which sensor point (1 to 5)

SOt il Marm S (ROMaY Sanon! m DIGITAL - G to read from, and choose between digital or analog mode depending

on your application needs

Let’s try the examples of these two sensors

Line Follower example
==,

[=] 055 e ]

S

&

Obstacle avoider example




- Ultrasonic & Line-Follower sensors MC4.0 Manual - Block-Based programming

Ultrasonic & Line-Follower I12C Sensors

'-—/
The MC4.0 kit includes an ultrasonic 12C sensor and a 6-channel line-follower I12C sensor, that can be easily controlled using the

block-based programming language. With the latest sensor update, multiple sensors can now be connected in series using a single

port, significantly reducing port usage on the controller and allowing more efficient hardware expansion.

The ultrasonic sensor features RGB eyes that enable object detection and accurate distance measurement. The line-follower sensor

identifies variations between dark and light surfaces, allowing the MC4.0 to follow paths, tracks, or predefined courses with

precision.
RGB Ultrasonic I>C sensor

faitrasn F!D = o The block initializes the RGB ultrasonic 12c sensor and must be placed before the main ioop to ensure

proper operation; it can be configured to use PORTA.

Get RGB ultrasonic target distance value mode ([Z.YHED (return float) e With this block, you can read the ultrasonic value in MM or CM

6-way Color Line Follower I12C Sensor

This block is used to initialize the line follower i2c sensor. It must be placed before the main loop and

Init line follo r i before any actions involving the sensor. You can initialize the sensor on either Port A beacuse PORTA

is i2c pin.

This block, we can initialize the sensor in main loop. Select the mode to

| Set six-channel line follower sensor mode to J{]ERi00 R e detect a specific color, black line, binary values, or set it to idle mode.

This block reads data from a selected point (1-6) of

= _ N - { i the 6-channel line follower 12C sensor and allows
Getﬂx-chennel line follower sensor 1 ' 2 ‘ 3 ‘ 4 l 5 ' 6 ‘ choosing between digital or analog mode based on

application requirements.

- . - : _ _ — This block initializes the sensor and gets values according to the selected
| Get six-channel line follower sensor current mode

mode.

Let’s try the examples of these two Sensors

Line Follower example

Obstacle avoider example




Script programming (Python and C++)

Get ready to take your coding skills to the next level

it's time to take your programming skills to the next level and dive into the world of script programming. With this powerful
tool, you can create more complex programs, add more functionality to your kit, and take full advantage of the capabilities
of the sensors and modules available to you. In this section, we'll explore the basics of script programming for the MC4.0
kit and show you how to write your first scripts to control the kit in new and exciting ways.

Hello World

In MCLab, transitioning from block-based programming to Python script programming is as easy
as clicking a button. This makes creating your first "Hello World" program in Python a breeze.

As we mentioned earlier, the "Hello World" program is the cornerstone of programming,

I Event one click to switch between

Blockly and Python
Iv ul

I Label

EToS Hello MC4.0

!b Hardware

Ib Units

II- Modules

» loTCloud

MC Cloud

EzData

After creating your "Hello World" program in block-based programming, you can easily convert it to Python using the button in
MCLab. This allows you to see the Python code that corresponds to the blocks you used.

|

MakerAndCoder
MakerAndCoder_ui
uiflow

screen = MCScreen()
screen.clean_screen()
screen.set_screen_bg color(®

labeld MCLabel('MC4.0"', x=115, y=111, Gx208, font-FONT_MONT_ 26, parent

label®.set_text{'Hello MC4.8')

From there, you can continue to learn and explore more advanced concepts in Python programming. With our platform's simple

and user-friendly interface, you'll be on your way to becoming a skilled Python programmer in no time.
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Once you have loaded and selected an image, you can easily switch to Python code and notice how to initialize the photo within

the MC4.0 controller using Python.

& miab [

MakerAndCoder
MakerAndCoder_ui
uiflow

screen = MCScreen()
screen.clean_screen()

screen.set_screen_bg_color(@xFFFFFF) T 5 s
= . initialize an image with

MCImg(“res/happy_Yellow.png“, x=28, y=8, parent=N

If you want to select a different image from the ones that are already loaded, you can use the following function:

imageO0: as an object defined from the previous line
image0.set_img_src("res/Happy_Yellow.png") . the function to call an image is : set_img_src
one parameter here refer to the name of the image

—

— > —
As long as you have completed the previous RGB example using block-based programming, you can easily convert the code into
Python script programming to further understand the difference. By switching to Python, you can edit the code and add more

functionality to the program

I' Hardware
Speaker

l Microphone

I RGB
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Script programming in Python offers more flexibility and control compared to block-based programming. With Python, you have

the ability to write custom code and manipulate variables directly, giving you more precise control over your project.

=Qer GOHERAD Z@E:

r—

In this section, we will delve into the functions responsible for controlling the movement of the MC4.0 kit, including how to control
each motor, adjust motor speeds, and read encoder values, in addition, to obtaining ultrasonic data, changing the color of the MC4.0

eyes, and obtain line follower values.

robo.init_motor_module()

robo.set_motor_speed(1, 1, 50) Set motor conirol moler n (1~ 4) diir n (0~ 1) speed ﬂ (0~ 100)

fobip & Bohacar) e This is needed object to run all possible functions
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(s1, s2, 53, 54, s5) robo,ow_multi_line_get_sensor_values() Rt el il e Kfowss s §| O |2 O |3 00 4L OO0 |8 £ !

Follow our learning platform on our website to access a wealth of knowledge and prepare yourself for your

éV\AI( I%

EXPLORE, INNOVATE, EXCEL

duino IDE
N —2

—

g
f
i
c
]
c
]
]
v

Welcome to the world of MC4.0! In this section, we will introduce you to the Arduino IDE compatible. You will learn how to write,
compile, and upload programs to your kit, and get hands-on experience with a few basic projects. Whether you're a beginner or an
experienced programmer, this section will provide you with the knowledge you need to get started with MC4.0 programming in

Arduino IDE. So, let's dive in and explore the endless possibilities!
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Before starting this installation procedure, you need to have Arduino IDE installed on your computer.

There are two versions of the Arduino IDE you can install: version 1 and version 2.

F

To install the MC4.0 board in your Arduino IDE, follow these next instructions:

™

=

& MC4.0 | Arduino IDE 2.0.1

File Edit Sketch Tools Help

N 1. from the file menu choose Preferences , then in Preferences dialog box enter the
following into the “Additional Board Manager URLs" field:

Open... o _ . _ _

Open Recent

Examples

Close

Save

Save As...
Preferences... Cirl+Comma
Advanced

Quit

DOIAIES MARAGTH ChatGFT_Rabot ino
7
20 while (WifL.status() = M COMMECTID) {
Q Tepe:  AB - 20
1]
| Arduino AVR Boards 1 L} ]
it i i
Ex] 5
1 4
¥
.
m
24 5
W a
at 5
41 i
Arduino ESP32 Boards &
try Archuina 4 L]
24, M-arduinn $ stolied = }
Poar, wpel in this package a6
&7 (-]
[ | :
a
=i | ©
53
53
Boards -, o e 1
i 1 81 thi pctage i
il Fedgn Contral :
Mo it 57 |

4 INSTALL Outpay

(6]

]
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2. Open the Boards Manager. Go to Tools > Board > Boards Manager

& MC4.0 | Arduino IDE 2.0.1

C ools ip

° e Auto Format
Archuve Sketch
Manage Libranes
Seral Monitol

1al Plotter

Board: “Arduino Uno® Boards Managet... Ctri+Shift+B

Arduino AVR Boards
WiFi101 / Wik iNINA Firmware Updater
Upload S5L Root Certificates
Programmer

Burmn

all button for the “Maker & Coder™

Fide Edit Sketch Took Help

006 I

11 "\n[ChatGPT] a co
I irb g a 3-da rip san Dis {

-

>

L

:1—r}

Open Libraries Manager from Sketch > Include Library > Manage Libraries
& MC4.0 | Arduing IDE 20.1 o x |

Maruace | it aies T+ Shill»
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Search for M5Core2 and press install button for the “M5Stack™
.um.olmlmmezm e e o e

Arduino Uno -

LIBRARY MANAGER MC4 0.ino
: |
| mbcore2 l void setup() { |

/ put your setup code here, o run once!

Type All v
Topic All v

}
I mh ESP32-Chimera-Core by
tobozo,Lovyan03
See more on
hitps.//github comAobozo/ESPI.
Chimera-Core
Alternate library 18
M5Stack/M5Core2/Odroid-
Go/D-Duino and possibily
other ESP32/TFT/SD bundles
More info

146~ INSTALL

M5Core2 by M55tack

See more on

hitps.//docs mbstack com/enicor
Library for M5Stack Core2
development kit

Mare info

016w INSTALL

void loop() {

/ put your main code here, to run repeatedly:

1
2
3
4
5
6
7
8
9

From the pop=up box click on INSTALL ALL

& MC4.0 | Arduino IDE 2.0.1 — (=] X

Install library dependencies X

The library M6Core2:0.1.5 needs some other dependencies currently not installed

« M5-RoverC
-M5-ADS1115

- Adafruit SGP30 Sensor
- M5Unit-EXTIO2

- M5Unit-Sonic

- M5Unit-ENV

- MSUnit-RTC

- Adafruit TCS34725

- ClosedCube TCA9548A
- M5Family

- Ethernet2

- M5Unit-RELAY

- MSUnit-Encoder

- Ms-DLight

- MSGFX

- FastLED
- ADXL345
- M5_EzData
- Adafruit MCP4725
Would you like 1o install ail the missing dependencies?

( INSTALL WITHOUT DEPENDENCIES )
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Plug the MC4.0 Controller to your computer. With your Arduino IDE open, follow these steps:

1. Select your Controller from Tools > Board menu > Maker & Coder > MC4.0

& MC4.0 | Arduino IDE 2.0.1 = (8] X
File Edit Sketch  Tools

Help

° e Auto Format
KA

Sketch
MC4.0 Manage Libraries..,

Aonitor

Senal Plotter

f" Board: "Ardumo Uno™
rd Info Arduino AVE
: 01 / WiFiNINA Firr date M ey

Upload SSL Root Certificates

MW ammer

2. From the Tools menu, Select the Port (if you don't see the COM Port in your Arduino IDE, you need to install the MC4.0 Driver
& MC4.0 | Arduino IDE 2.0.1 - g X
File Edit Sketch Toals Help

° Auto Format

Archive Sketch

MC4.0.ir

Manage Libranes..

3. To install the USB driver for MC4.0:
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3. Open the following example under File > Examples > M5Core2 > games > floppybird

& MC4.0 | Arduino IDE 2.0.1

File Edit Sketch Tools Help

New

Open...

Open Recent

Examples

Close

Save

Save As...

Preferences...

M5Core2

Advanced Advanced

Quit Basics
KIT
Module
Touch
Unit
core2_for_aws

games floppybird

A A

Enjoy playing Flappy bird game

In this example, we'll show you how to control the MC4.0 kit using the Arduino IDE.
To start, we'll need to include the required libraries and files. We'll be using three
files: two for the motor drivers and one for the MC4.0 image to be displayed on the
screen. In the setup function, we'll initialize the MC4.0 and the screen. Then, we'll

move the kit in a specific sequence, with 1.5 seconds for each movement: left, right,

SCoDER

WWW.MAKERANDCODER.COM

Scan for Arduino IDE example

forward, backward, and some diagonal directions.
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Download Firmware
— - -—/

Firmware is a type of software that is installed on a hardware device, such as the MC4.0 kit, and provides low-level control of the

device's functions. It is typically designed to control the behavior of the hardware, manage interactions with other devices, and
provide a stable platform for the software applications that run on the device. Firmware is often pre-installed on devices, but

can also be updated or replaced to improve functionality or fix issues.

It's important to note that if you're switching from the Arduino platform back to MCLab, you'll need to reinstall
the firmware on the kit. This is because the firmware is different for each platform, and switching between
them requires a firmware update.

To install the firmware on the MC4.0 kit, you'll need to follow these steps:

1. First, download the latest firmware version from the official Maker & Coder website.

2. Next, connect your MC4.0 kit to your computer using a USB cable.

3. Once the firmware burning tool is downloaded, open it and select the right COM port for your

MC4.0 kit. You can find the COM port information in the Device Manager on your computer.

4, After selecting the correct COM port, click the "Erase" button to
MCLab Flash Tool

clear the controller's existing data in preparation for installing the

latest firmware,

AKER
CODIL=

EXDLORE. INNOVATE EXCEL

4. After selecting the correct COM port, click on the "Burn" button to

start the firmware installation process. You'll see a progress bar that

Mc4- o firmware shows you the percentage of completion.

COM: | COM3

Baud:

1500000

5. During the firmware installation process, a command prompt
window will pop up. This is normal and it's part of the installation
process. Don't close this window until the firmware installation is

complete.

6. Once the firmware installation is complete, the MC4.0 kit will

automatically restart and return to its initial status.
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AFTER - SALES SERVICES AND TECHNICAL SUPPORT

If you come across any issues with the quality of the product or
discover any missing or damaged parts upon opening the
package, or if you require any technical support, please reach out
to us for after-sales assistance via the following contact
information:

Support@makerandcoder.com

(Service Hour: 9:00-17:00 (+4 GMT) from Monday to Friday)

www.makerandcoder.com
Designed & Marketed: Maker and Coder

Address: Golden Gate - 204, 2nd Floor - 113 Umm Hureir Road
Oud Metha - Dubai - United Arab Emirates

Phone: +971 4 318 0283
What's App: +971 56 398 2854
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